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Introduction
The purpose of this manual is to provide steps on how to digitize brackishwater 
ponds from survey maps into GIS data, which is also known as shapefiles. The 
manual elaborates the installation process of two software, QGIS 3.XX and 
Google Earth Pro, to allow users to smoothly implement the instructions in 
this manual.

If the user has already installed QGIS, proceed to Step 8 and skip the 
installation instructions. Please note that some features may look different 
in older and newer QGIS versions as compared to version 3.16 used in this 
manual. If the user already has Google Earth Pro installed in the computer, 
skip the installation process as discussed in Step 34 and proceed to Step 39.

The goal of introducing Google Earth Pro in this manual is to explain to users 
how this free open-source tool can replace the previous practice of purchasing 
expensive high-resolution satellite images to confirm the location of the 
mapped brackishwater ponds. The large database of images on Google Earth 
Pro allows users to confirm if the digitized lot has been correctly mapped and 
converted from the provided Technical Descriptions of the survey maps. Since 
the survey map provides the correct Barangay, Municipality, and Province, 
the digitized lot should appear in the same location on Google Earth Pro. 
If the lots do appear in the correct location, but the shape appears to be 
inconsistent with the images from Google Earth Pro, then this provides more 
information to the user – that the pond has expanded, converted, etc. The 
last part of the manual provides some screenshots on what other information 
can be extracted from the large repository of data from Google Earth Pro.

List of Requirements
1. QGIS (long-term release)
2. Google Earth Pro
3. Survey plan of a brackishwater pond

• Fishpond Lease Agreement (FLA) documents can be obtained from 
Department of Agriculture – Bureau of Fisheries and Aquatic Resources 
(DA-BFAR) Fisheries Regulatory and Quarantine Division (FRQD)

• Non-FLA fishpond documents can be obtained from Department of 
Environment and Natural Resources – Land Management Services 
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(DENR-LMS) or Provincial Environment and Natural Resources Office 
(PENRO)

4. Other documents containing fishpond lot information:
• Tax declarations from Provincial or Municipal Assessor’s Office
• Property Identification Map from Municipal Assessor’s Office

5. Coordinates of a tie point, also called benchmark or monument – can 
be requested and obtained from DENR-LMS, PENRO, Municipal ENRO 
(MENRO), or Land Management Bureau (LMB, previsouly called Bureau 
of Lands)

6. Internet (needed for items 1 and 2 above)

A. Setting-up QGIS
1. Check the operating system of the computer (Windows, macOS, or Linux) 

being used, as well as the system type (32 or 64-bit). For Windows, go to 
the File Explorer, right click on “This PC” or “My Computer” and click on 
Properties. This will provide the basic information of the computer.

2. Go to https://qgis.org/en/site/forusers/download.html.
3. Open the Downloads Tab in the QGIS webpage corresponding to the 

computer’s operating system, as identified in Step 1. Under the Long-Term 
Release Repository (most stable) list, select the appropriate Standalone 
Installer version. 
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4. Install QGIS in the computer.
• Run the downloaded installer.

• Select a Destination Folder, click on Next and then click Install.

• Click Finish once the installation is complete.
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5. Navigate to the desktop and look for the QGIS folder. The folder will have 
5 different short cuts. For this manual, the QGIS Desktop will be utilized. 
The shortcuts can also be accessed through the Start menu.

6. Open QGIS Desktop. For computers with freshly installed QGIS (first time 
users), a welcome message will appear. Click on “Let’s get started!” to 
run the software. The speed of the loading of the software would depend 
on the computer’s specifications. The more powerful the laptop is, the 
faster the software will load. 

7. The default interface of QGIS will allow users to open previous projects 
that they have previously been working on their computers. But if QGIS 
was freshly installed, old projects will not be available for them and will 
look like the interface found below: 
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Note: internet connection is needed for steps 8-9.

8. Click Plugins from the toolbar and then Manage and Install Plugins. It will 
connect to the repository of QGIS plugins. 

9. In the search bar, type “azimuth”. Click on the Azimuth and Distance 
Plugin and then click on the Install Plugin button to download and add 
the plugin to the QGIS functions.



Digitization of Brackishwater Fishpond Lots 7

The speed of the download and installation will depend on the quality of 
the internet connection of the user. If the download and installation of the 

plugin fails, click on the “Install Plugin” button again. If it persists, the internet 
connection might be too weak/slow.

10. Once the plugin is successfully installed, new options will be available 
for the Azimuth and Distance Plugin – “Uninstall Plugin” and “Reinstall 
Plugin”. Once the Plugins window is closed, the Azimuth and Distance 
Plugin can be accessed through this icon .
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11. Click on the Azimuth and Distance tool . The Azimuth and Distance 
window will appear at the bottom part of the user interface.

If this error appears, restart QGIS and run the plugin again. 

12. Click the Options tab and follow the settings below:
• Survey type: Boundary
• Angle type: Bearing
• Distance unit: Default
• Angle unit: Default
• North type: Default
• Drawing: Open attribute form is checked 
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Bearing is selected for the angle type as survey plans typically indicate bearings 
instead of azimuth. More information on bearings and azimuth are found in the 
following links: https://en.wikipedia.org/wiki/Azimuth and https://en.wikipedia.

org/wiki/Bearing_(navigation).

13. Click on the Drawing tab. The Starting point, corresponds to the X and 
Y coordinate of the “tie point” or “benchmark” identified on the survey 
plan. A short explanation on what info goes to which part of this plugin is 
provided in the image below. More details on where to get the information 
from the survey plan is provided in the next section.
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14. Change the Coordinate Reference System (CRS) to PRS92 with the correct 
zone by clicking Project on the menu bar then Properties. This opens 
the Properties window. Click on the CRS tab, type in “PRS” on the filter 
box to show all related coordinate systems. Based on the location of the 
fishpond to be plotted, select PRS 92 and the appropriate zone from 1-5. 
Click on OK to apply the coordinate system for the entire map and all 
succeeding lots to be plotted.

Important reminder: After changing the reference system, make sure to digitize 
fishpond lots that are also found within the same zone (e.g., municipality, 

province, or region).

B. Encoding of technical descriptions
In this section, the Azimuth and Distance plugin will be used to convert the 
printed technical descriptions found on the survey plans of fishpond lease 
agreements into digital form (shapefiles). Below is sample survey plan. 
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Each survey plan’s layout is unique, but it will usually have the following 
components:
• A map of the lot – this is usually found in the middle of the survey plan. 

This shows where the points (identified by numbers – 1, 2, etc.) of the 
lot are located and the names of the lots surrounding the lot in focus. 
Sometimes it provides a true Easting and Northing (X and Y coordinate) of 
a point, which can help in plotting the lot. It also provides the tie point or 
benchmark where the 1st corner of the lot is connected to. 

• Details of the lot ownership – it is usually found on the right side of the 
survey plan. It will contain information on who requested the survey 
(this is likely the owner of the lot), where the lot is located (barangay, 
municipality, province and island), the total area in square meters, and 
date of the survey.

• Tie point or benchmark – a tie point or benchmark will be identified 
as any of the following: BLLM (Bureau of Lands Location Monument), 
PBM (Political/Provincial Boundary Monument), CBM (City Boundary 
Monuments), MBM (Municipal Boundary Monument), BBM (Barangay 
Boundary Monument), and BLBM (Bureau of Lands Barrio Monument). 
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As indicated in the sample FLA-6189 survey plan, the tie point is identified 
as “BLLM No.1 Ajuy Cad. 560-D”, of which the actual coordinates can be 
requested from the LMB, DENR-LMS, PENRO, MENRO, or online sources. 
If the benchmark information is obtained from online sources, it is advised 
to double-check the information from official government records for 
consistency and correctness. Obtaining the correct tie point coordinates 
is manadatory s this provides the correct and accurate positioningand 
projection of the fishpond lot on Google Earth Pro.

• Technical Description (TD) – contains the bearings and distances from 
one point of the lot to the next point. In FLA-6189 survey plan, the TD 
is found on the upper left portion of the plan, but it can also be found 
elsewhere on the plan. Sometimes, it is even absent from the plan and 
rather, the bearings and distances are found near/along the boundaries 
of the drawn lot.

To start plotting a fishpond lot, the first step is to find the X and Y coordinates 
of the tie point identified on the survey plan. For the survey plan shown below, 
the benchmark is identified as BLLM #1 in the Municipality of Ajuy, Iloilo.
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Online sources indicate the geographic position and coordinates of Ajuy BLLM 
No.1 as shown in the figure (Fernandez, 2012; Feliciano, 2019).

   

The tie point or benchmark 
information must be obtained from 

the  LMB, DENR-LMS, PENRO, or 
MENRO before starting the plotting 

exercise.

15. The Azimuth and Distance tool accepts the projected coordinates of any 
tie point. Therefore, from the given information on Ajuy BLLM No.1, the 
Philippine Plane Coordinate System (PPCS) coordinates must be used for 
the starting point. To do this, input the Easting 501,942.7636 for X and 
Northing 1,235,590.3758 for Y on the Azimuth and Distance tool under 
the Drawing tab.

It is highly advised to acquire the coordinates of the tie point or benchmark 
indicated in the survey map. If the tie point information is not available, the X 
and Y  values can be assumed at 20,000.00 and 20,000.00. However, this must 
be changed to the correct tie point coordinates prior to exporting the shapefile 

otherwise the digitized fishpond lot will not be properly projected to Google 
Earth Pro or other mapping software.

16. Identify the bearing and distance of Corner 1 from the tie point or 
benchmark. This is usually written near Corner 1 on the survey plan. A 
bearing will usually provide an angle in degrees (⁰) and minutes (‘) with 
North/South and East/West direction and a distance in meters.
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17. Under Next Vertex, input the bearing into the azimuth box and the 
distance into the corresponding distance box. Click Add to Bottom. The 
New Vertex will now appear under the Segment List of the plugin. Note: 
Always click Add to Bottom for every entry!

The format of bearing should be as follows: A(space)##d(space)##’(space)
B. Following the details found on the survey plan: A is either ‘N’ or ‘S’ and B is 

either ‘W’ or ‘E’. The small ‘d’ is the representation of “degrees” (⁰) and ‘ ’ ’ is the 
“minutes”. The numbers in between (##) are the values provided on the survey plan.

18. Repeat Step 17 to encode all the bearings and distances found on 
the Technical Description of the survey plan. Double check if all the 
information has appeared on the Segment List of the plugin. If any item 
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does not match, double-click on the cell and edit its contents.

19.  If the actual tie point coordinates were used for encoding the technical 
information, skip this step and proceed to Step 20. On the other hand, 
if the tie point information is not available and the local coordinates (E: 
20,000.00, N: 20,000.00) were used, click on the Export button to save 
the segment list. This will allow editing and changing the Starting Point 
information afterwards with the actual tie point coordinates from the 
LMB, DENR-LMS, PENRO, or MENRO, without having to repeat the entire 
process of inputting all the technical description again.

When the actual tie point coordinates are already available, click on 
the Import button and locate the saved segment list. Once you have 
successfully imported the Segment List into the Azimuth and Distance 
tool, change the Starting Point with the correct coordinates of the actual 
benchmark before clicking on Draw. The new plot that will be drawn will 
now have the correct location due to the provision of the actual tie point 
information.

20. When all the information on the Starting Point (Tie Point) and Segment 
List macth the Technical desciption, click on Draw.
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21. Click OK on the tmp_plot – Feature Attributes window that appears after 
clicking on Draw. A new layer named tmp_plot will appear on the Layers 
part of the QGIS user interface. Close the Azimuth and Distance window.
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22. Click on the Zoom Full  button (View >> Zoom Full) to view the 
shapefile. It should be identical to the plotted lot found on the survey 
plan. If the shape of the tmp_plot on QGIS differs from the plot on the 
survey plan, it might be due to errors during the input of the technical 
description into the Segment List. Check the Segment List on the Azimuth 
and Distance tool to make sure that the inputs are consistent with the 
technical description. If it is, and the plots still do not match, check the 
Options settings of the tool, and make sure it follows the settings as 
described in Step 12. 

23. After the plot has been drawn (Step 20), check that the CRS should be 
set at PRS92 with the correct Zone. To do that, right click on the tmp_
plot layer file and click on Properties. Look for the Source tab and the 
information on Assigned CRS. In this example, it should be set to PRS92 
Zone IV and click on OK button to apply the change.

Important reminder: Check and ensure that fishpond lots being digitized are  
found within the same zone (e.g., municipality, province, or region).
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C. Adding key information  
To include the necessary information about the lot ownership found on the 
survey plan, the newly created GIS file/shapefile must have an attribute table.

24. Right click on the new layer tmp_plot and click Open Attribute Table. The 
new window that will appear is the Attribute Table. Make sure that the 
Toggle editing mode is clicked/activated and then click on the New Field 
button.
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25. The Add Field window will appear. The setting that will be selected will 
depend on the information that will be inputted – whether it will be 
letters, numbers, symbols or a combination of these. 

•	 Name: should correspond to the Title of the information to be inputted
•	 Type: there are a lot of Types but for the purpose of this manual, only 2 

types will be utilized. If information to be inputted is composed of numbers 
only, select Decimal number (real). If input information contains a combi-
nation of letters, numbers and symbols or special characters, select Text 
(string).

•	 Length: number of characters for Text type and number of digits for numbers
•	 Precision: this is for numbers only, which corresponds to the number of 

decimal places that will be reflected from the inputted numbers

Since the survey plan plotted on this manual is a fishpond lease agreement, 
the FLA Number should be one of the information found on the attribute 
table. “FLA No.” can be the name of the first field. As an FLA number will 
contain a combination of letters, numbers, and sometimes symbols or 
special characters, it would be best to select Text (string) as the field type. 
Click OK. A new field (column) will appear and will have the name “FLA 
No.” It’s first entry will have the “NULL” information, which is a default. 
The “FLA No.” information can already be inputted, if desired, or it can 
also be done after all the other fields have been added.
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26. Continue adding new fields depending on all the necessary information 
that must be included in the attribute table. To add new fields, click on 
the Add New Field and repeat Steps 24-25. 

Below are the recommended fields such as Owner and Area. For the 
location, separate fields for the barangay, municipality and provinces 

are recommended as it will allow better search when multiple shapefile 
datasets are eventually combined.

27. Once all necessary fields have been added on to the attribute table, more 
columns or fields will appear on it. The cells will also initially be empty 
with a gray italicized “NULL” in it. Click on a cell to edit its contents. The 
information to be inputted should match the details on the survey plan.
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28. To save all the information, click on the Save Edits button (or press CTRL+S 
on the keyboard) then click on the Toggle editing mode to turn off the 
editing mode.

D. Exporting into ESRI shapefile and KML format
29. Save the created polygon and all added information. Right click on the 

layer tmp_plot and click Export then Save Feature As…. The Save Vector 
Layer as… window will appear with default settings. 

30. Select ESRI Shapefile format. Save the file by clicking on the ellipsis button 
. The Save Layer As window will appear. Select a location where the file 

should be saved, provide a file name and click Save.
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The information provided 
through the ellipses button 
is a required step or else an 

error will appear.

31. Check the reference system (PRS/Philippines zone XX) on the CRS box. 
Click OK to run the exporting of the layer. If the “Add saved file to map” 
was checked, the new file will appear on the Layers.

32. Repeat steps 29-31 to save the same layer in KML format.
33. On the keyboard, press CTRL + SHIFT + S to save the QGIS file. After saving, 

close the QGIS app.
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E. Setting up Google Earth Pro
34. Open a web browser and access the link: https://www.google.com/earth/

versions/. Click on Google Earth Pro on desktop then Download Earth Pro 
on desktop. A list of terms from Google will pop-up, click on the Accept 
& Download button. Depending on the internet browser used, several 
options can be done to the installer for download such as (a) Run the 
installer immediately, (b) Save the installer to a default download folder, 
(c) or save it in a preferred folder through Save As. Any of the 3 options 
are fine but if the save option is selected, a message at the bottom of 
the browser will notify users that the installer has finished downloading. 
Run the installer. Three pop-up windows will appear consecutively – 
downloading, installing and installation complete. The last one will signify 
that the installation process was successful, and Google Earth Pro will 
immediately be launched. Close the last pop up and look for the Google 
Earth Pro user interface.
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The speed of the download and installation will depend on the quality of the 
internet connection of the user. If the download and installation of Google 
Earth Pro consistently fails despite many attempts, the internet connection 

might be too weak/slow.
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35. If Google Earth Pro has not launched, 
go to Start and find Google Earth Pro 
from the list.

36. The Google Earth Pro user interface will begin with Start-up Tips. Users 
can click on the different options found on the list to learn more about 
the tool before they begin using it. Click on Close to access the actual 
software.

37. Go to Tools and select Options…. The Google Earth Options window will 
appear. The default settings will be changed based on the next instruction, 
so users have better ease in using and navigating through the software.
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38. Go to the Navigation tab and change the settings as follows, then click OK 
to accept the changes:
• Fly-To-Speed: drag the bar close to the Fast end of the scale
• Do not automatically tilt while zooming
• Untick the Gradually slow the Earth when rotating or zooming.
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F. Checking the digitized lot on Google Earth Pro
39. On the File tab, click Open and look for the KML file that was previously 

saved. Select the KML file and click on Open. The KML file will be loaded 
on Google Earth as a polygon.

Loading the KML file on Google Earth will allow users to check if the digitized lot 
is in the appropriate location and this is primarily dependent on the Tie Point’s X 
and Y coordinates. Correctly encoded tie point coordinates projects the digitized 
lot to approximately match a fishpond on the satellite image. On the other hand, 

incorrect tie point coordinates results to the digitized lot appearing in a random and 
questionable location, sometimes in the middle of an urbanized area or in the Pacific 
Ocean. When this happens, double check the encoded tie points for the digitized lot 
(through the Azimuth and Distance plugin, Step 15), the reference system settings 
(WGS 84/PRS 92 Zone 4), or the raw tie point documents from respective agencies.
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The next steps will require very good internet connection. If this is not possible 
for the user, the next steps may not be successfully attempted.

40. The Time Slider tool will also allow users to check the area from different 
dates depending on what data/images are available on Google Earth Pro. 
Usually, several satellite images are available within the past 10-15 years, 
with the best quality in the more recent years. Some images have severe 
cloud cover or may appear too dark that details are not distinguishable.

The images available will vary for every other area. Some area may have a 
dense set of images. In some areas, there might be no available images. The 
quality of images is also varied as shown in the example above. Some may be 

very clear and have high resolution, others may be pixelated, and cloud covered.
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G. What else can Google Earth Pro do?
The following scenarios could be determined using the Time Slider tool:

If the digitized plot was previously a mangrove area:

If the digitized plot was a very active pond in previous years but currently 
reverting to mangroves:

If the digitized plot was a very active pond in previous years but has currently 
been converted into a built-up area:
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Introduction of the Annex
The Manual on Mangrove Reversion of Abandoned and Illegal Brackishwater 
Fishponds by Primavera et al. (2014) discussed the process of inventory and 
mapping of brackishwater ponds as summarized in the figure below. 

The main contents of this manual break down the first two steps (a. construct 
the polygon of each fihspond lot and b. align polygons with the satellite 
image) into more detailed instructions using QGIS mapping software. 

To supplement the manual, the annex Spatial Processing and Analysis of 
Digitized Fishpond Lots discusses in detail the remaining steps in mapping 
brackishwater fishponds, e.g., assigning polygon color according to pond 
classification, comparing the area and location of digitized fishpond lots, and 
finalizing the fishpond map. 
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SPATIAL PROCESSING AND ANALYSIS OF 
DIGITIZED FISHPOND LOTS
JD Coching

Processing of digitized fishpond lots can be done using QGIS, ArcMap, or 
Google Earth Pro. Each software has its own advantages and disadvantages 
and requires different levels of operational skills. Google Earth Pro is the 
recommended software as it already integrates satellite images as base map. 
It requires minimal technical background for the operation of its simple user 
interface. On the other hand, QGIS and ArcMap do not readily incorporate 
satellite images in the map, which needs to be done manually or with the 
help of plug-ins for QGIS. These programs have tools and controls available 
for performing more detailed spatial analyses compared to Google Earth Pro. 
However, this results in a complicated user interface and a need for higher 
operational skills. In terms of availability, Google Earth Pro and QGIS can be 
downloaded online for free while ArcMap needs to be purchased.

This chapter discusses the detailed steps in processing and analyzing digitized 
brackishwater fishpond lots using Google Earth Pro. These steps are as follows:
A. Loading digitized fishpond lots into Google Earth Pro
B. Classifying fishpond lots
C. Cleaning and screening fishpond lots
D. Adding fishpond lots without technical descriptions
E. Adding undocumented fishpond lots
F. Creating the brackishwater fishpond database map

A.  Loading digitized fishpond lots into Google Earth Pro

1. Open Google Earth Pro.
2. Load digitized fishpond lots into Google Earth Pro by:

a. Open “File” menu >> “Open” (Fig. 1).
b. Locate and select corresponding KML or ESRI shapefiles for the 

corresponding fishpond lots. At this stage, all uploaded KML or 
shapefiles are stored in the “Temporary Places” folder. Files in the 

Suggested Citation: Coching JD (2021). Spatial Processing and Analysis of Digitized Fishpond 
Lots in Digitization of brackishwater ponds from survey plans to GIS shapefiles. Deutsche 
Gesellschaft für Internationale Zusammenarbeit (GIZ) GmbH, Germany. vi + 52  pp pp. 
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“Temporary Places” folder are 
lost upon closing Google Earth 
Pro.

3. Create a polygon for the digitized 
fishpond lot using the “Add 
Polygon” tool (Fig. 2).
a. Click on “Add Polygon” tool. 

This open a “New Polygon” 
dialog box.

b. Provde a name for the polygon.
c. Set polygon corners based on 

most probable actual fishpond 
lot as seen in the satellite image 
while following the overall 
shape of the uploaded shapefile.

4. Save uploaded files and created polygons to “My Places” folder (Fig. 3):
a. Click-hold-drag the desired folders and files into “My Places” folder.
b. Right-click on the “Temporary Places” folder or selected KML or 

shapefiles and select “Save to My Places”.
c. Open “File” menu >> “Save” >> “Save to My Places”.

By this point, the polygons and digitized fishpond lots should be in the 

FIG. 1. Load digitized fishpond lots 
through File menu and selecting 
option to Open. Image from 
Google Earth Pro.

FIG. 2. Adding a polygon for the uploaded fishpond lot in Google Earth Pro.
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“My Places” folder. Additional folders can be added and files for digitized 
fishpond lots can be further sorted according to province, municipality, or 
other preferences.

5. Save all files and all changes applied in Google Earth Pro through “File” 
menu >> “Save” >> “Save My Places” (Fig. 4). 

Steps 4-5 are necessary to avoid losing all uploaded files and the accompanying 
changes applied, such as renaming, sorting, and adjusting file properties. Files 
stored in the “Temporary Places” folder will be lost upon closing Google Earth 
Pro.

The sample figures and images presented only includes FLA and titled fishpond 

FIG. 3. Different ways of saving files to My Places folder in Google Earth Pro.

FIG. 4. Saving 
all changes and 

progress done in 
Google Earth Pro 

by opening File 
menu >> Save >> 

Save My Places. 
Image from 

Google Earth Pro.
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lots. On the other hand, tax declaration forms may sometimes contain 
technical descriptions of fishpond lots. However, this depends on the tax 
declaration format being implemented by respective local government units. 
Digitize these technical description following the previous chapter and upload 
all KML or shapefiles for Tax-Declared fishpond lots as discussed above.

B. Classifying Brackishwater Fishponds

1. Classify the digitized brackishwater fishpond lots whether as (a) Titled 
Pond, (b) Fishpond Lease Agreement (FLA) Pond, (c) Tax Dec. Only, or (d) 
Undocumented. Follow the guidelines presented below (Table 1):
a. Classify a fishpond as Titled pond if it has a corresponding property 

title, either as Original Certificate of Title (OCT) or Transfer Certificate 
Title (TCT), with or without an overlapping FLA contract and/or Tax 
Declaration documents.

b. Classify a fishpond as FLA Pond if it has a corresponding FLA contract 
and is not a titled property, with or without an overlapping Tax 
Declaration document.

c. Classify a fishpond as Tax Dec. Only if is only documented with a tax 
declaration and there are no corresponding property title and FLA 
contract. 

d. Classify a fishpond as Undocumented if there are no corresponding 
legal documents for its ownership or operation. Refer to Section C for 
additional details on how to identify undocumented fishpond lots.

2. Create a folder for each fishpond type as identified in Step 1.
3. Sort and move individual digitized fishpond lots into their corresponding 

fishpond type and folder by either:
a. Click-hold-drag individual fishpond lots.
b. Select, cut, and paste individual fishpond lots.

Classification and sorting of individual fishpond lots into different types and 

TABLE 1. Guidelines in classifying digitized brackishwater fishpond lots.

Documents
Classification

Property Title
(OCT/TCT) FLA Contract Tax 

Declaration

Titled Pond + + +/-
+ - +/-

FLA Pond - + +/-
Tax Dec. Only - - +

Undocumented - - -
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respective folders, following 
the steps presented above, can 
be done before uploading the 
shapefiles or KML files to Google 
Earth Pro. Regardless of doing 
these steps before or after, the 
end result should somehow be 
similar to Fig. 5.

4. Select and open a folder’s 
properties by either of the 
steps below:
a. Right-click on the folder 

>> “Properties”, or
b. Open “Edit” menu >> 

“Properties”.

5. In the “Style, Color” tab of the “Edit Folder” dialog box (Fig. 6), set the 
following details:
a. Line thickness at least 1.5 and opacity at 100%
b. Line color per category shown below:

i. Red – FLA ponds
ii. Blue – Titled fishpond lots

iii. Yellow – Tax Declaration only
iv. Violet – Undocumented fishponds

c. Color Fill and Opacity – these details are optional but can be used 
to highlight the individual lots. Use the same colors as the lines and 

FIG. 5. Classified and sorted fishpond lots into 
different types with corresponding folders.

FIG. 6. Edit 
a folder’s 
properties by 
right-clicking 
on a folder 
and selecting 
Properties. 



Spatial Processing and Analysis 39

respective categories.
6. Double-check sorting and classification of fishpond lots. Sometimes, an 

area may still be represented by two or more tenure types (Fig. 7). In 
this case, apply the classification guidelines presented in Step 1. On the 
other hand, steps on how to process irregular fishpond area overlaps are 
discussed in Section C.

7. Save all changes applied through “File” menu >> “Save” >> “Save My 
Places” (Fig. 4).

C. Cleaning and screening fishpond lots 

Digitized fishpond lots may sometimes overlap with one another or may not 
represent an actual fishpond as seen in satellite images, thus contributing 
errors in the total area of brackishwater fishponds. Clean out and finalize the 
fishpond lots by following the steps discussed below.

1. Navigate and zoom in to the target fishpond area.
2. Validate the digitized lot as an actual fishpond through satellite imagery.

a. Click on the “Show Historical Imagery” tool to show the “Time Slider” 

FIG. 8. Show Historical 
Imagery tool reveals 
all available satellite 
images of a particular 
area which can be 
displayed by moving 
the time slider left and 
right.

FIG. 7. Sample digitized fishpond polygons represented by two tenure types where 
(top) the total area is covered by the FLA and (bottom) some difference in the 
polygon shape and size. Imagery from Google Earth Pro.
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(Fig. 8).
b. Move the “Time Slider” left or right to show available satellite images 

of the target area. It may be necessary to look into at least 2-3 satellite 
images for better assessment of the area.

c. A digitized lot is considered as an actual fishpond by the presence of 
any, or all, of the following characteristics (Fig. 9-11):
• Water within the digitized pond area,
• Distinguishable pond dikes and water gate(s) surrounding a body 

of water,

FIG. 9. Sample of digitized tax-dec-only lots which are not fishponds (orange 
outline) as shown through several satellite images taken at different years. Imagery 
from Google Earth Pro.

FIG. 10. Sample of digitized lot which are not fishponds (orange outline) as shown 
by its distance from the shore (yellow line) and lack of access to seawater. Imagery 
from Google Earth Pro.
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• Vegetation in watery areas (secondary growth of mangroves), 
which only applies to abandoned fishpond,

• Proximity to the sea or access to seawater through canals,
• Lower elevation (at 0m) as compared to other areas (see Box 1).

3. Remove digitized lots which do not qualify as a fishpond as these will 
result to errors in the total area (hectares) of brackishwater fishponds.

4. Look for possible overlapping fishpond lots as indicated by any, or all, of 
the following (Fig. 13):

BOX 1. Determination of elevation using Google Earth Pro.

Water level inside brackishwater fishponds are typically at 0 m elevation on 
Google Earth Pro, same as the sea and other open water areas. Thus, areas with 
water bound by dikes but are more than 0 m elevation may not be fishponds and 
could be rice fields. Check for the elevation profile (Fig. 12) of the target area 
with the following steps below:
a. Click on the Ruler tool. This opens a dialog box with several tabs.
b. Select Path tool.
c. Click on the map to set the path start and end points.
d. Click and drag path points to adjust path length and position.
e. Select preferred unit of measurement.
f. Tick on the Show Elevation Profile. This displays the elevation profile along 

the identified path.

FIG. 11. Sample digitized lot which is not a fishpond (orange outline) as shown by its 
elevation, estimated at 50 m above sea level. Imagery from Google Earth Pro.
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FIG. 13. Sample overlaps of different fishpond lots which contribute to errors in 
total area of fishpond lots. Imagery from Google Earth Pro.

FIG. 12. Showing 
the elevation 
profile of the 

target area using 
the Ruler tool. 
Imagery from 

Google Earth Pro.

a. Fishpond lot enclosing a separate smaller fishpond lot within,
b. Fishpond lot with two or three lines crisscrossing through the area,
c. Fishpond lot with two different colored boundary lines,
d. Fishpond lot with very irregular shape.

5. Create a polygon for the overlapping portion of the fishponds using the 
“Add Polygon” tool (Fig. 14)
a. Click on “Add Polygon” tool. This open a “New Polygon” dialog box.
b. Provde a name for the polygon.
c. Set line and fill properties in the “Style, Color” tab as desired to 
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enhance polygon visibility.
d. Set polygon corners to cover the overlapping fishpond areas.
e. Click on the “Measurement” tab and set units of measue as prefered, 

e.g., kilometers for perimeter and hectares for area (Fig. 15). 
f. Copy and record the overlapping area and indicate these fishponds 

in the invetory.
g. Click at the OK button at the bottom of the dialog box.

6. Save all changes 
applied in Google 
Earth Pro through 
“File” menu >> “Save” 
>> “Save My Places” 
(Fig. 4) 

7. Subtract the 
duplicates, non-
fishpond lots, and 
overlapping areas 
from the total 
brackishwater 
fishpond area.

Steps 4-7 focus directly on FIG. 15. Measurement of fishpond perimeter and area 
can be set in different units. 

FIG. 14. Creating a polygon for overlapping fishpond lots using Add Polygon tool and 
determining its total area. Imagery from Google Earth Pro.
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the specific overlapping portions of fishpond lots. An alternative approach is 
to create a polygon encompassing the entire fishpond lots and using the total 
area of that polygon in the inventory and area computations. However, this 
can only be applied for fishpond lots of the same classification. 

D. Adding fishpond lots without technical descriptions

Some titled and tax-dec-only fishpond lots do not have technical descriptions, 
or the information cannot be accessed. On the other hand, FLA lots may have 
technical descriptions but are illegible, e.g., faded prints or torn pages. In 
these cases, photographs, or scanned images of Tax Maps, also called Property 
Identification Maps, can be georeferenced and used to delineate these 
fishpond lots. Tax Maps show all real properties covered by a tax declaration 
and are obtained from the Municipal or City Assessor’s Office. Individual real 
properties are assigned with a lot number and listed with their corresponding 
title number or FLA number (Fig. 16). Tax maps may include additional details 
such as creeks, mangrove areas, or roads, which can be used for estimating 
the location and delineating the boundary of fishpond lots. Follow the 
steps below for georeferencing tax maps and add corresponding polygons 
for additional fishpond lots. Note that the sample tax map is modified for 
instructional purposes and cannot be used as a reliable source.

1. Navigate and zoom in/out to the target municipality and barangay as 

FIG. 16. Sample Tax Map, or Property Identification Map, showing individual lots 
and corresponding fishpond type. Note that fishpond type in this sample tax map is 
modified for instructional purposes (photo by ZSL-Philippines/IDTayo).



Spatial Processing and Analysis 45

FIG. 17. Target area with fishponds and their corresponding classification as 
indicated in the tax map. Imagery from Google Earth Pro.

indicated in the tax map (Fig. 17).
2. Click on the “Add Image Overlay” tool. This opens the “New Image 

Overlay” dialog box and image boundary guide (Fig. 18).
3. Provide a name for the tax map image overlay.
4. Click on the “Browse” button and select desired Tax Map image.
5. Change tax map image transparency by moving the adjustment button 

left or right.
6. Adjust the size and position of the tax map image to match major details 

in the satellite image such as known fishpond lots, roads, mangrove 
areas, or bodies of water (Figs. 18-19).
a. Resize the image by moving the corner guides.
b. Reposition by moving the center guide.
c. Rotate image by moving the diamond button on side guides.

7. Click on OK at the bottom of the “New Image Overlay” dialog box upon 
adjusting the tax map image as desired (Fig. 18). 

The overlaid tax map (Fig. 19) may not necessarily match the satellite image 
and may only approximate individual fishpond lots. However, take note of the 
classification of each fishpond lot as indicated in the tax map.

8. Create a polygon for corresponding fishpond lots without an existing 
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FIG. 19. Tax 
Map overlaid 
in Google 
Earth Pro 
approximately 
matching 
individual 
fishpond lots.
Imagery from 
Google Earth 
Pro.

FIG. 18. Adding the tax map image overlay in Google Earth Pro. Provide a name and 
browse for the image file. Modify transparency by moving the adjustment button 
left or right. Imagery from Google Earth Pro.
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FIG. 21. Added polygon representing Tax-Dec-Only fishpond lots following the 
discussed steps and based on a separate tax map section. Imagery from Google 
Earth Pro.

FIG. 20. Added polygons representing FLA and titled fishpond lots without technical 
descriptions based on tax maps. Properties were modified accordingly. Imagery 
from Google Earth Pro.
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FIG. 22. Sample undocumented brackishwater fishpond identified based on 
presence of distinguishable water gate, and canals, presence of secondary mangrove 
growth, access to seawater, and presence of water enclosed in dikes. Imagery from 
Google Earth Pro.

boundary. 
a. Classify the added polygon accordingly as indicated in the tax map or 

list of fishponds (Fig. 20). 
b. Adjust line and fill properties in the “Style, Color” tab following the 

details in Section B Step 5.b.
c. Sort fishpond polygons accordingly.

9. Repeat the steps above to create polygons for tax-dec-only fishpond lots 
and for other barangays with fishponds (Fig. 21).

10. Save all changes applied in through “File” menu >> “Save” >> “Save My 
Places” (Fig. 4). 

E. Adding Undocumented Fishpond Lots

1. Check for potential brackishwater fishponds not yet included in the 
classification process discussed in Section C. Refer to Step 2.c above for 
identifying possible brackishwater fishponds (Fig. 22).

2. Create a polygon for the additionally identified brackishwater fishponds. 
Adjust line and fill properties in the “Style, Color” tab following the details 
in Section B Step 5.b (Fig. 23).
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FIG. 24. Sample of undocumented brackishwater fishponds identified in 
representative sites. Imagery from Google Earth Pro.

FIG. 23. Creating a polygon for undocumented brackishwater fishpond using the 
Add Polygon tool. Settings of color fill and opacity is optional. Imagery from Google 
Earth Pro.
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3. Record the total area of the fishpond and add this data to the overall  
inventory of fishponds.

4. Sort the additional fishponds as Undocumented fishpond lots (Fig. 24-25).

F. Creating the brackishwater database map 

The brackishwater fishpond database map is saved as an image file. Using 
Google Earth Pro, save the entire brackishwater fishpond database by the 
following steps:

1. Click on “Save Image” icon (or through “File” menu >> “Save” >> “Save 
Image”). This opens a toolbar with “Map Options”, “Resolution”, and 
“Save Image” located above the satellite image view (Fig. 26).

2. Click on “Map Options”. Tick to check “Title and description”, 
“Compass”, “Scale”, and “Legend”.

3. Click and drag to configure map details as desired (title, description, 
legend, scale, compass).

4. Click on “Resolution” button and select desired image quality.
5. Click on “Save Image” and this opens the “Save As” dialog box (Fig. 27).

a. Select desired drive and folder location.
b. Provide a preferred filename.
c. Select JPEG Image (*.jpeg) file type.
d. Click on “Save” button.

6. Retrieve and locate the saved image file of the brackishwater fishpond 
map. A sample map output using Google Earth Pro is presented in Fig. 28.

The primary objective of mapping brackishwater fishpond is to identify 

FIG. 25. Sample data set of 
digitized fishpond lots classified 
and sorted into FLA, Titled, Tax 
Declared, and Undocumented 
fishpond lots. Image from 
Google Earth Pro.
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FIG. 26. Export the map image file using Save Image tool. Set and edit map options 
to include a title, legend, compass, and scale. Imagery from Google Earth Pro.

potentially abandoned government-owned ponds and those with questionable 
or no documentation and determine their location and total area (hectares). 
Remember to subtract the area of duplicate lots, non-fishpond lots, and 
overlapping portions of fishponds. 

On the other hand, additional spatial analysis of digitized fishpond lots can 
be done as follow:
− Determine FLA lots covered by Titles – loss of government land to 

private ownership; implications on the titling process
− Determine how many FLA and Titled fishpond lots do not have tax dec 

forms – loss in tax revenue of local government unit

FIG. 27. Save the 
brackishwater fishpond 

map in JPEG format, 
provide a filename, and 

select the desired file 
storage location. Image 
from Google Earth Pro.
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FIG. 28. Sample brackishwater map showing FLA and undocumented fishpond lots. 
Imagery from Google Earth Pro.
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